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Chapter 1

Preface

The TC/LINK-SC7 is a service process which performs bidirectional message (fax, SMS, email) transfer
between an SAP 7.x system and the Kofax Communication Server. It uses the SAPconnect messaging
interface of SAP to communicate with the SAP system. (The abbreviation “SC7” refers to the used
interface “SAPconnect” and to the version number of the supported SAP system.)

TC/LINK-SC7 is the successor of the TC/LINK-SC product. TC/LINK-SC used the RFC (“Remote Function
Call”) sub-interface of the SAPconnect interface. Since SAP NetWeaver 7.0, the SAPconnect RFC is no
longer supported for email. As of SAP NetWeaver 7.3, you can maintain only SMTP nodes in transaction
SCOT. Since SAP 7.0, SAPconnect supports an SMTP interface instead of the RFC interface. Therefore,
TC/LINK-SC7 connects to SAPconnect via the SAPconnect SMTP interface instead of the RFC interface.
This is the crucial difference between TC/LINK-SC7 and TC/LINK-SC. TC/LINK-SC7 is based on the TC/
LINK-SM generic product (“SMTP link”) and not on the original TC/LINK-SC product.

Note User can continue using RFC based solutions for sending faxes. However, we strongly
recommend switching to SMTP based solutions. As of SAP NetWeaver 7.3, user can maintain
RFC nodes only using transaction SCON.

From technical point of view, TC/LINK-SC7 is an SMTP server: It implements an SMTP listener for SAP-
outbound message transfer, and, at the same time, an SMTP client for SAP-inbound message transfer.

TC/LINK-SC7 is, of course, still part of the Kofax TC/LINK product family and therefore it has all TC/
LINK common features such as document conversion features, configurable covers and templates,
configurable address mapping, and so on. Please refer to the TC/LINK manual to learn more on these
generic features.

TC/LINK-SC7 does not support dirsync (automatic creation of shadow users), just as TC/LINK-SC.

Differences TC/LINK-SC7 <-> TC/LINK-SC
• The “old” TC/LINK-SC uses the SAPconnect RFC interface. TC/LINK-SC7 uses the SAPconnect SMTP

interface. So, TC/LINK-SC7 requires a completely different SAP-side configuration than TC/LINK-SC.
E.g., TC/LINK-SC uses one or more SAPconnect RFC nodes for SAP-outbound message transfer.
These RFC nodes have to be created during the TC/LINK-SC SAP-side-setup manually. TC/LINK-SC7
uses the one-and-only SAPconnect SMTP node. This SMTP node does not have to be created. This is
already shipped with the SAP installation. 
Also, with TC/LINK-SC7, the whole RFC-related infrastructure (LIBRFC32.DLL, SAPRFC.INI,
registry settings SAP\RFC… ) on link-server side does not exist anymore. Instead, there is an SMTP-
communication related infrastructure on the link-server side, to be configured with the registry settings
TCLSM\...
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• With TC/LINK-SC7 there is no similar tool as the TC/LINK-SC tool TC/Monitor TC/LINK-SC Add-on.
The main purpose of this tool was to alleviate the duplication of the RFC configuration/infrastructure on
the link-server. As TC/LINK-SC7 does not use RFC, so, there is no need for this tool.

• TC/LINK-SC7 does not support send time handling. Reason: the SAPconnect SMTP node does not
offer this feature (=transmission time restriction according to message priority). So, there is no similar
configuration setting like the “old” TC/LINK-SC setting SAP\AcceptSAPSendTime.

• The SAPconnect SMTP node cannot transfer the SAP cost center information at all, so in TC/LINK-
SC7 there is no similar configuration setting (and corresponding functionality) like the “old” TC/LINK-SC
setting SAP\UseSAPCostCenter.

• TC/LINK-SC has supported sending messages with SAP address type ‘X400’ (SAP-outbound),
however, TC/LINK-SC7 does not support it anymore, because the SAPconnect SMTP node does
not support SAP address type X400. This also means that there are no TC/LINK-SC7 counterparts
for the “old” TC/LINK-SC registry settings SAP\SCLinkX400ADMD, SAP\SCLinkX400Country, SAP
\SCLinkX400Org, SAP\SCLinkX400U1, and SAP\SCLinkX400PRMD.

• It is not possible with TC/LINK-SC7 to redefine the temporary directory used by the link instance.
(There is no equivalent registry setting to SAP\TempPath).

• The SAPconnect SMTP interface does not transfer the originator SAP user ID when sending a SAP-
outbound message. So TC/LINK-SC7 cannot be configured to use the SAP user ID as originator for
SAP-outbound messages. That is, there is no equivalent registry setting / functionality to the “old” TC/
LINK-SC registry setting SAP\ChangeOrig.

• Furthermore, with TC/LINK-SC7 there is no equivalent registry setting / functionality to the following TC/
LINK-SC registry settings:
• SAP\BinaryAttachments
• SAP\IgnoreFileName
• SAP\EnableEncryption

Licensing
To run TC/LINK-SC7, a KCS license with type TC/LINK-SC7 is needed. This is a link-instance based
license. This means, it restricts the number of parallel running TC/LINK-SC7 instances connected to the
KCS server.

For sending SAP-outbound faxes, also one on the following KCS document-conversion licenses is
needed, depending on what kind of format conversion is configured on the SAPconnect SMTP node for
the fax message type:

Configured format on
the SAPconnect SMTP
node

KCS license needed Description

PostScript TC/POST For PostScript to KCS fax format conversion with TCIMGO conversion
(it uses the optional Lincoln converter library).

PCL TC/PCL5 For PLC5/PCL6 to KCS fax format conversion with TCIMGO
conversion (it uses the optional Lincoln converter library).
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These document-conversion licenses are workstation based licenses. This means, the logged on link
server machines are counted with the license counter. If a link server was granted the right, then every link
instances on this server can use the according conversion feature.
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Chapter 2

Installation

This section describes the installation of TC/LINK-SC7.

Installation Scenarios
This section describes various installation scenarios.

Additional SMTP Relay Scenario
SAPconnect SMTP node is connected to the TC/LINK-SC7 through an SMTP relay. The SMTP relay finds
the TC/LINK-SC7 SMTP server by MX record lookup.

Benefits:
• MX record fail-over / load balancing for SAP-outbound message transfer is possible.
• The remaining SAPconnect internet email traffic is handled by the additional SMTP relay and not by

TC/LINK-SC7.

Drawbacks:
• More complex structure: additional SMTP relay is needed; the TC/LINK-SC7 SMTP server must be

registered in the DNS.
• The SMTP relay server represents still a single point of failure, and SAP itself does not offer a (not

third-party) solution to this problem: SAPconnect has only one single SMTP-node, and this is connected
to a certain SMTP server defined by FQDN (fully-qualified-domain-name) or IP address.
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Configuring the connections:

1) SAPconnect SMTP node -> SMTP relay connection (SAP-outbound transfer):

SCOT / SMTP node / parameter Mail Host = fully qualified domain name or IP address of the SMTP relay
PC
SCOT / SMTP node / parameter Mail Port = 25

2) SMTP relay -> LINK-SC7 connection:
• Register the link domain in DNS. (It must be same domain that is defined also in the registry setting

TCLSM\SMLinkDomain and at the SCOT / SMTP node / fax and pager address types.)
• Enter MX records to this domain referring to LINK-SC7 computer–1 and LINK-SC7 computer–2.
• TCLSM\Port2TC = 25 on both link computer.

3) LINK-SC7 <-> KCS connection:

Topcall\Path = TCP/IP,KCS-1-name|TCP/IP,KCS-2-name

Note The KCS tandem double-connection is defined with the pipe ‘|’ symbol.

4) LINK-SC7 -> SAP WAS SMTP server connection (SAP-inbound transfer):

On the both link PCs:

TCLSM\SMFixedRecipient (MULTI_SZ) =

Fully qualified domain name of SAP SMTP server 1

Fully qualified domain name of SAP SMTP server 2 (fallback server if server-1 cannot be reached)
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TCLSM\Port2SMTP = the port configured in the SAP WAS profile for the given SAP-client, see
configuration of the SMTP listener on the SAP Web Application Server.

Direct Link Connection Scenario
SAPconnect SMTP node is connected directly to the TC/LINK-SC7. In this configuration, exactly 1 link
server / 1 link instance is connected to the given SAP client. Benefits and drawbacks are just the opposite
as with the SMTP-relay-scenario.

Benefits:
• Simpler structure: no additional SMTP relay; no need to register TC/LINK-SC7 SMTP server in the DNS

Drawbacks:
• No fail-over when the connected link server / link instance is out of order.
• No load balancing for SAP-outbound message transfer.
• Additionally, the whole SAPconnect internet email traffic (if any) will necessarily flow through TC/LINK-

SC7, because SAPconnect has only one single SMTP node and this will be served by the TC/LINK-
SC7 SMTP server. So, if there is SAPconnect internet email traffic on the system, then TC/LINK-SC7
must be configured to relay mode.

Configuring connections:

1) SAPconnect SMTP node -> LINK-SC7 connection (SAP-outbound transfer):

SCOT / SMTP node / parameter Mail Host = FQDN or IP address of the LINK-SC7 computer

SCOT / SMTP node / parameter Mail Port = TCLSM\Port2TC

2) LINK-SC7 <-> KCS connection:

Topcall\Path = TCP/IP,KCS-1-name|TCP/IP,KCS-2-name

(Note: the KCS tandem double-connection is defined with the pipe ‘|’ symbol.)

3) LINK-SC7 -> SAP WAS SMTP server connection (SAP-inbound transfer):
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TCLSM\SMFixedRecipient (MULTI_SZ) =

FQDN of SAP SMTP server 1

FQDN of SAP SMTP server 2

TCLSM\Port2SMTP = as configured on the SAP WAS profile for the given SAP-client

Windows NLB-Cluster Connection Scenario
SAPconnect SMTP node is connected to a TC/LINK-SC7 NLB-cluster (Network Load Balancing)
installation.

In this configuration, more than 1 link servers are connected (by the common NLB IP-address) to the
given SAP client.

For the detailed description of the TC/LINK-SC7 NLB-cluster installation please refer to TC/LINK-SM
manual / “Windows NLB cluster installation”. (This description applies to all TC/LINK-SM-derived links
including TC/LINK-SC7.)

Benefits and drawbacks:

Benefits:
• Simpler structure: no additional SMTP relay; no need to register TC/LINK-SC7 SMTP server in the DNS
• Fail-over/high availability for the SAP-outbound message transfer provided by NLB + TCSRV NLB port

control feature.
• Load balancing with very flexible scaling-possibility
• NLB is free of charge, easy to configure with the Network Load Balancing Manager utility (since

Win2003srv SP2)

Drawbacks:
• Nevertheless, extra NLB configuration is necessary
• The whole SAPconnect internet email traffic (if any) will necessarily flow through TC/LINK-SC7,

because SAPconnect has only one single SMTP node and this will be served by the TC/LINK-SC7
SMTP server. So, if there is SAPconnect internet email traffic on the system, then TC/LINK-SC7 must
be configured to relay mode.
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Configuring connections:

1) SAPconnect SMTP node -> LINK-SC7 connection (SAP-outbound transfer):

SCOT / SMTP node / parameter Mail Host = NLB cluster IP address

SCOT / SMTP node / parameter Mail Port = TCLSM\Port2TC

2) LINK-SC7 <-> KCS connection:

Topcall\Path = TCP/IP,KCS-1-name|TCP/IP,KCS-2-name

Note The KCS tandem double-connection is defined with the pipe ‘|’ symbol.

3) LINK-SC7 -> SAP WAS SMTP server connection (SAP-inbound transfer):

TCLSM\SMFixedRecipient (MULTI_SZ) =

FQDN of SAP SMTP server 1

FQDN of SAP SMTP server 2

TCLSM\Port2SMTP = as configured on the SAP WAS profile for the given SAP-client

Installation for Multiple SAP Clients (‘mandant’)
Separate TC/LINK-SC7 instance(s) have to be used for each individual SAP client. Especially, when these
individual SAP clients are installed on a single SAP application server.

Reason: Each SAP client uses an individual SMTP port for SAP inbound messages/notifications.
However, TC/LINK-SC7 does not use any ‘port based’ routing mechanism when transporting a message
to SAP. TC/LINK-SC7 sends all messages to the same SMTP port as defined in TCLSM\Port2SMTP.

Note, that using an intermediate SMTP relay between TC/LINK-SC7 and SAP in SAP-inbound (!) direction
is a not-validated scenario. However, this scenario is used by some customers. This installation makes
possible, that a single TC/LINK-SC7 instance is connected to more than one SAP application servers
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(and perhaps clients) at the same time. E.g. to a SAP production system and to a SAP test system. In this
case, it must be made sure, that all SAP user addresses involved in the TC/LINK-SC7-messaging are
unique. E.g. it leads to SAP-inbound notification assignment problems when TC/LINK-SC7 is connected
to a production and a test system as described above, and the test SAP system contains the same SAP
user/address as the productive system.

Prerequisites
• Any supported operating system on link server. For more details about supported operating systems,

refer to Platform System Manual.
• SAP 7.x system, already installed.
• KCS server already installed and a KCS link user (to be used by TC/LINK-SC7 to login into KCS)

already created.

Note default link user ‘TCLINK’ is available anyway.

• Firewall / TCP/IP infrastructure issues:
TC/LINK-SC7 has to be able to establish SMTP connection to the SAP WAS SMTP server at the port
(to be) configured in the SAP application server profile.

Additionally, in case of ‘additional SMTP relay’ scenario:
• The (common) link domain for all alternative TC/LINK-SC7 servers is registered in DNS.
• SMTP relay server with active ‘DSN’ ESMTP feature is installed / available.
• Firewall / TCP/IP infrastructure issues:

The SAPconnect SMTP node has to be able to establish SMTP connection to the SMTP relay.
The SMTP relay has to be able to establish SMTP connection to the TC/LINK-SC7 SMTP servers.

Additionally, in case of ‘direct link connection’ scenario:
• Firewall / TCP/IP infrastructure issues: 

The SAPconnect SMTP node has to be able to establish SMTP connection to the TC/LINK-SC7.

Overview of Installation Steps
• Check the prerequisites (set up the SMTP relay server and do necessary DNS setup in case of

‘additional-SMTP-relay’ scenario; configure firewall / TCP/IP infrastructure if needed); see Prerequisites
• Install the TC/LINK-SC7 service on the link PC(s) (Kofax Communication Server setup); see Installation

of the TC/LINK-SC7 Service
• Check or install the necessary KCS licenses; see Licensing
• Do according configuration steps on SAP 7 manually; seeSAP 7 Setup for TC/LINK-SC7
• Test the operation

The following data must be known or planned in installation time:
• KCS server name (primary and secondary, if any)
• KCS link user / password (needed only if you want to use another user as the default ‘TCLINK’)
• Link domain name (virtual or also real, depending on the installation scenario)
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• SMTP port on the link computer
• Name(s) of SAP Web Application Server(s) hosting the SMTP service (fully qualified)
• SMTP port on SAP WAS
• SAP domain name (= SAPconnect ‘default domain’ setting)

Installation of the TC/LINK-SC7 Service
Run the Kofax Communication Server setup program to install the TC/LINK-SC7 service.

The following description describes the first TC/LINK-SC7 installation. Nevertheless, the setup program
can be run any time again to modify the configuration parameters or to add some not yet installed
components (such Lincoln converter). In this case, you get the same setup dialog sequence as with the
first installation, however, the configuration parameters shown in each setup dialogs are not the proposed
default values, but the currently configured values.

1. Go to the Links group.
2. From the links, select the TC/LINK-SC7.
3. Click Install.

4. “BASIC parameters…” setup dialog: enter the connection data to the (already installed) Kofax
Communication Server and enter the codepage configured on KCS and on the link PC:
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(Please refer to the TC/LINK manual for details on these parameters.)
5. If Kofax Communication Server (KCS) type is defined as “Tandem” server, then enter the connection

data to the secondary KCS server on this subsequent dialog:
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6. Normally, there is nothing to change/enter on the “Document converter setting” dialog. Simply click
OK to accept defaults.
Please refer to the TC/LINK manual for details on these parameters and on a possible non-default
configuration.

7. Normally, the default link user ‘TCLINK’ is available on KCS (automatically created on KCS setup)
and can be used by TC/LINK-SC7 to login into KCS. So, simply click OK.
Please refer to the TC/LINK manual for details on these parameters.

Normally, (almost) nothing to change or enter on the following “ADVANCED” dialogs:
(Please refer to the TC/LINK manual for details on these parameters and on a possible non-default
configuration.)
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8. Click OK to accept defaults:

9. Click OK to accept defaults:

10. Enter the language for error messages, otherwise accept defaults:
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11. Click OK to accept defaults:

12. Click OK to accept defaults:

13. Click OK to accept defaults:

14. Accept installing Lincoln converter and define whether Greek or Japanese support for Lincoln is
needed.
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(Normally, Lincoln converter will be needed only if PS or PCL format is configured on the
SAPconnect SMTP node for fax address type. That is, if SAP is configured to send the fax image in
PS or PCL format to TC/LINK-SC7.)

15. Click OK: (TC/LINK-SC7 does not offer the directory synchronization feature, so there is no need to
define a type to it.)

16. Enter the following parameters on the subsequent “Setup SMTP and SAP parameters” dialog:

Link Domain Name (registry: TCLSM\SMLinkDomain): Logical domain belonging TC/LINK-SC7. It
can be any arbitrary string that satisfies the SMTP address-domain-part syntax. It does not have to
be necessarily a registered DNS name or entered in the Hosts file. This is the domain served by TC/
LINK-SC7 as SMTP server. Nevertheless, if the TC/LINK-SC7 SMTP server has a registered DNS
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name and TC/LINK-SC7 is reached by DNS (additional SMTP relay installation scenario) then the
registered DNS name have to be used here.
SAP outbound messages must use recipient addresses with this SMTP address domain part, in
order to be served by TC/LINK-SC7. Also, the SAPconnect SMTP node must be configured so, that
it builds the according fax and pager SMTP addresses with this domain. That is, this domain must be
entered on the fax and pager address type setup on the SAPconnect SMTP-node, in the “Parameter
Conversion into Internet Address” / Domain edit field. See SAP configuration description, STEP-5.

Note that setup adds this domain and all sub domains (*) to the list of routable domains (TCLSM
\SMRouteDomains).

SMTP Port on Link Server (registry: TCLSM\Port2TC): Configures the port the TC/LINK-SC7
SMTP server will listen to for SAP-outbound messages. In the “additional SMTP relay” installation
scenario it must be 25. Otherwise, if the SAPconnect SMTP node is directly connected to the TC/
LINK-SC7 (the Mail Host configured on SAPconnect SMTP node is the TC/LINK-SC7 machine), then
this setting must be the same as the Mail Port configured on the SAPconnect SMTP node. See SAP
configuration description, STEP-5.
Connection to SAP (registry: TCLSM\UseDNS): Normally, the default setting ‘by SAP server name’
have to be used. In this case, on the consecutive setup screen you can enter the SAP SMTP servers
for the SAP-inbound connection. The option ‘by DNS MX records’ can only be used if the SAP SMTP
servers are registered in DNS and has according MX records definitions. In this case, TC/LINK-SC7
determines the SAP SMTP servers by DNS/MX record lookup. It can be used to setup for MX record
load balancing.
SAP domain name (registry: SAP\SAPDomain): Default domain configured on SAPconnect (SCOT).
See SAP configuration description, STEP-4.) This information is used by TC/LINK-SC7 to build the
SMTP address for SAP-inbound fax and SMS.
Service for Sending to SAP (registry: SAP\OwnService): Accept the default ‘SC7’. (TC/LINK-SC7
will create KCS service with this name on KCS, when starting TC/LINK-SC7 first time. This service
has to be used to send messages to SAP. E.g. this service must be used in the ‘service’ part of the
“<service>,<number>” TCfW addressing syntax when sending some test message from TCfW to
SAP.)
For all other parameters accept the displayed default value. Please refer to TC/LINK-SM and TC/
LINK manual for IP masking option, Time Zone support and SSL configuration.
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17. Enter the SAP SMTP server(s) and according SMTP port to which TC/LINK-SC7 sends the SAP-
inbound messages / notifications.

SMTP port on SAP application server (registry: TCLSM\Port2SMTP): SMTP port configured on the
SAP SMTP server(s). Note that all SAP SMTP servers entered on this screen must use the same
SMTP port number because TC/LINK-SC7 uses this single port number for sending to all alternative
SMTP servers. This port number coincides with the port number configured in the SAP application
server profile in transaction RZ1Ø, see SAP configuration description, STEP-1.
Fully Qualified SAP Server Name (1) … (10) (registry: TCLSM\SMFixedRecipient): Fully qualified
domain name of the SAP SMTP server belonging to the virtual host of the SAP client (’Mandant’)
that TC/LINK-SC7 will connect. If there are more than one alternative SMTP servers, then define it
in fallback-order. (The additional servers will be used by TC/LINK-SC7 as fallback but not as load
balancing.)
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18. Click OK to accept defaults:

Description of these parameters (more information on these settings in the TC/LINK-SM manual):
Enable TCP trace (registry: TCLSM\TCPDebug): Yes … writes all data from / to the internet to the
trace file. If switched on and with the general trace level set to 0x0, a plain SMTP/MIME trace will be
created.
Maximum hop count (registry: TCLSM\MaxHopCount): Indicates the maximum number of hops
before a message originally sent to SMTP is re-routed to the local post master as a problem report.
Hops are counted by means of the MIME “Received:” timestamps.
Maximum message size from SMTP in bytes (registry: TCLSM\MaxSizeFromSmtp): configures a
limit for messages received from SMTP. Note that the limit is only applied if the connected client/host
supports the EHLO/SIZE SMTP extension (RFC 1870).
Maximum message size to SMTP in bytes (registry: TCLSM\MaxSizeToSmtp): configures a limit
for messages sent to SMTP. If a MIME-encoded message is larger, it will be negatively terminated on
KCS (error text: “SM: Message too large”).
Combine all text blocks to a single block (registry: MIME\SingleTextBlock): If checked, TC/
LINK-SC7 will put all text of the message to SMTP together and position it at the beginning of the
message. All attachments follow after the text block.

19. Click OK to exit setup:

SAP 7 Setup for TC/LINK-SC7
This section describes the SAP 7 setup for TC/LINK-SC7.
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Overview
To enable the SAP system to communicate with TC/LINK-SC7 through its SMTP interface it is necessary
to carry out some configuration on the SAP side. These configuration steps have to be considered as part
of the TC/LINK-SC7 installation procedure. Nevertheless, they have to be performed manually.

Overview of the configuration steps:

Configuration for SAP-inbound message/notification transfer (mandatory):
• STEP-1: Configuring the SMTP listener on the SAP Web Application Server (Transaction RZ1Ø)
• STEP-2: Creating a service user for the incoming mail processing (Transaction SUØ1)
• STEP-3: Setting up the SMTP service (Transaction SICF)

Configuration for SAP-outbound message/notification transfer (mandatory):
• STEP-4: Defining the Default Domain (Transaction SCOT)
• STEP-5: Configuring the SAPconnect SMTP Mail Server node (Transaction SCOT)
• STEP-6: Configure the Send Job (if not already configured) (Transaction SCOT)

Configuration for SMS transfer (optional):
• STEP-7: Configure the pager service (Transaction SA14)

Miscellaneous configuration:
• To be checked: mpi/total_size_MB (RZ1Ø)

Note Even if we want to send with TC/LINK-SC7 only in one direction (e.g. SAP-outbound faxes), the
configuration for the other transfer direction must still be done in order to be able to send / receive the
delivery status notifications.

Related SAP documentation

The following SAP documentation served as source for this configuration description:
• The “SMTP Configuration Guide” on the SAP help page (http://help.sap.com – no registration required

to view it). Hint: simply search with e.g. Google for “SMTP Configuration Guide”.
• SAP Note 455140 ("Configuration E-mail, fax, paging/SMS via SMTP"). It can be found on “SAP

support portal” / SAP Notes search”. Hint: simply search with e.g. Google for “SAP support portal”.
(Registration is required.)

STEP-1: Configuring the SMTP Listener on the SAP Web Application Server
(RZ1Ø)

1. Call transaction RZ10
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2. Import SAP application server profile (‘instance’ profile) when not yet imported. Select menu:
Utilities > Import profiles > Of active servers.
(After installation or upgrade of an SAP system, the instance profile is stored at operating system
level file(s). The installation program itself does not store the profiles directly in the SAP database. It
must be first done manually to be able to maintain it with RZ10 / SAPGUI.)

After import:
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3. Select your instance profile. Use the selection button next to the Profile edit field.
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4. Choose the ‘Extended maintenance’ (radio-button) and click Display.

5. Click ‘Display <-> Change’ to be able to edit the profile parameters.
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6. Select the line before which you want to insert the new parameter and click ‘Parameter’ to insert a
new profile parameter (=line).

7. Enter the following configuration lines as described here:

For each SAP client using TC/LINK-SC7 its own SMTP listener must be configured. This can be
done with 2 configuration lines for each SAP client:
icm/server_port_<*> = PROT=SMTP,PORT=<port>,TIMEOUT=<timeout>
is/SMTP/virt_host_<*> = <host>:<port>;
(Note that if only a single client in the whole SAP system uses an SMTP listener, then the second line
is not required. In this case, is/SMTP/virt_host_0 = *:*; is assumed by default.)
Explanation:
The placeholder <*> is simply a sequence number (starting at zero) which used for profile
parameters occurring more than once.
The <port> parameter in the icm/server_port_<*> entry is the port the SMTP listener will listen to
(it must be a yet unused port!) and the same port number must be used in the according is/SMTP/
virt_host_<*> entry. Actually, it is exactly this same port number and nothing else (e.g. it is not the
sequence number) that establishes the assignments between the ‘icm/server_port_<*>’ profile entry
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and the belonging ‘is/SMTP/virt_host_<*> profile entry. Each virtual host has to be assigned different
port number.
The <host> parameter must be ‘*’ in our case.
Example:

a. When only 1 SAP client will use the TC/LINK-SC7 for message transfer, and no other clients
use an SMTP listener, then 1 configuration line similar to this have to be created:
icm/server_port_1 = PROT=SMTP,PORT=25000,TIMEOUT=180

The sequence number, 1 in this example, must be adapted: the next free number has to be
used.

b. When TC/LINK-SC7 is configured to be used in 2 SAP clients, then configuration lines similar to
these must be created:
icm/server_port_1 = PROT=SMTP,PORT=25000,TIMEOUT=180
icm/server_port_2 = PROT=SMTP,PORT=25001,TIMEOUT=180
is/SMTP/virt_host_0 = *:25000;
is/SMTP/virt_host_1 = *:25001;

(The sequence numbers and port numbers must be, of course, adapted. Simply the next free
sequence numbers have to be used. Each virtual host has to be assigned a unique free port
number.)
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8. Click Copy and then Back  (F3) and confirm parameter change. (Actually: entering a new

parameter.)

9. Click Back  (F3) and confirm profile change.

10. Menu Profile / Save (Ctrl + S) or Save button in toolbar.
11. Answer ‘Yes’ to Activate?-question or select menu Profile / Activate (F6).
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STEP-2: Creating a Service User for the Incoming Mail Processing (SUØ1)
1. Choose SAP menu: Tools > Administration > User maintenance > Users (or call transaction

SUØ1)

2. Enter the name of the service user to be created (an arbitrary, not yet existing name - e.g. “TCLINK”)
and select the menu Users | Create (or, alternatively, click the toolbar button with the white empty
page pictogram):

3. Enter an (arbitrary) “Last name” on the “Address” tab
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4. Enter an email address (recommended: “SAP-user-ID@SAPconnect-default-domain”, see “STEP-4:
Defining the Default Domain” installation step)
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5. Define User Type as “Service” and enter a password on the “Logon data” tab:
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6. Enter profile “S_A.SCON” on the “Profiles” tab:

7. Now, save the user data. (Menu Users | Save or click the toolbar button with the floppy disk
pictogram)
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STEP-3: Setting Up the SMTP Server (SICF)
1. Choose SAP menu: Tools  > Administration > Administration > Network > HTTP Service

Hierarchy Maintenance > Users (or call transaction SICF)
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2. Enter filter criteria Hierarchy Type = SERVICE and click the Execute button (or press F8)

In the service list you can find one pre-created SMTP server (“SAPconnect”) which is by default
equivalent to the virtual SMTP host #0. If you want to use TC/LINK-SC7 only for one SAP-client
(=”mandant”), then this SMTP server can be configured for this client, as described below.
However, if you want to use TC/LINK-SC7 for more than one clients (=mandant) in the SAP system,
then separate SMTP server must be used for each clients. So, new SMTP servers have to be
created for the 2nd, 3rd, … clients. (Menu Service/Host | Create Host )The configuration steps below
must be repeated in analogous way for each newly created SMTP server. Note that in this case
STEP-2 (service user creation) must be also repeated for each client, because the clients have
separate user pools.
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3. Double-click the SAPCONNECT (E)SMTP service from the service list

4. Click the pencil-and-glasses button for edit mode (or select SMTP Host | ‘Display <-> Change’ menu)
Host Data tab / ‘Profile Parameter No.’ field: enter here the sequence number of the according is/
SMTP/virt_host_<*> parameter from the instance profile (see previous step). If you have a one-client
configuration and therefore there is no according is/SMTP/virt_host_<*> parameter in the instance
profile, then enter 0.
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5. Logon Data tab: enter here the service user / its password created in STEP-2.

6. Handler List tab: Enter CL_SMTP_EXT_SAPCONNECT at position 1.

7. Click Save  (or press Ctrl-S) to save the changes.
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8. Right-click the according SMTP service line and select ‘Activate SMTP Host’ from the context menu.

STEP-4: Defining the Default Domain (SCOT)
1. Go to SAPconnect administration: SAP menu: Tools > Business Communication >

Communication > SAPconnect (or call transaction SCOT)
2. Chose Menu: Setting > Default Domain

The domain of this SAP system client (German: Mandant) is defined here, for example, 
sap-sys.mycompany.com. It is used for the following purposes:
The SMTP plug-in logs on to TC/LINK-SM (this is the mail server) with this domain as ID.
The message ID of outgoing mails is constructed with this domain.
If an SAP user who has not entered an Internet mail address in their user master record sends an
email, a sender address is generated from the SAP user name and this domain, for example 
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SMITHJ@sap-sys.mycompany.com.

3. Enter the default domain, e.g., sap-sys.mycompany.com
This domain must be the same as configured on the link with the registry setting SAP\SAPDomain.

STEP-5: Configuring the SAPconnect SMTP Mail Server Node (SCOT)
1. Go to SAPconnect administration: SAP menu: Tools > Business Communication >

Communication > SAPconnect (or call transaction SCOT)
2. Change to node view, if you are not already in this view. (Menu > View > Node)

(Hint: SAPconnect has more than one view: System status, Routing, Node, Jobs. When you enter
SAPconnect, always the view you have used last time will be displayed.)

3. Double-click on the SMTP node (on the text “SMTP” on the tree-view) to open the General node data
‘configuration dialog’
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(Each client has an SMTP node. This node is created by the SAP system and cannot be deleted.)
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4. Configure the General node data / ‘SMTP Connection’ section / Mail Host, Mail Port
The Mail Host, Mail Port fields must be configured according to the chosen installation scenario:

a. If the SMTP node will be connected directly to the TC/LINK-SC7 machine (remember, that TC/
LINK-SC7 is an SMTP listener, so it is a valid Mail Host), then
Mail Host: domain name or IP address of the TC/LINK-SC7 machine
Mail Port: the port the TC/LINK-SC7 SMTP-listener listens to, that is, the port number
configured in the TCLSM\Port2TC registry setting

b. If the SMTP node will be connected to the TC/LINK-SC7 through an SMTP relay server:
Mail Host: domain name or IP address of the SMTP relay machine
Mail Port: the port the SMTP relay listens to (configured on the SMTP relay server)

5. Configure the General node data / ‘SMTP Connection’ section / Code Page
Recommended value: “4110 Unicode UTF-8”

Explanation
This is the code page with which the message subject / message body text / text block attachments are
transported on the SMTP node when sending a SAP-outbound message, nevertheless, only then, when
there is no according code page definition in the SXCPSEND table (transaction SE16).

Normally, the language of the document determines the used code page with which the message subject /
message body text / text block attachments will be transported on the SMTP node when sending a SAP-
outbound message. The mapping between document language and used code page is defined in the
table SXCPSEND (transaction SE16). The SMTP protocol will use the according MIME character set. TC/
LINK-SC7 will convert the encoded text fields to the configured KCS codepage when storing the message
on KCS. However, when there is no code page definition for the language of the document on SAP in the
SXCPSEND table, then the code on the SMTP node will be used.

The code page set on the SMTP node has to satisfy the following conditions:
• offers the best coverage of the characters used in the sent messages
• compatible (=TC/LINK-SC7 is able to convert it) to the code page set on the KCS server (see table and

explanation below)

Note that the selection “4110 Unicode UTF-8“satisfies both of these conditions.

Warning! In most practical cases, the SAP-outbound faxes are sent as SAPscript/SmartForm documents.
These documents will be converted by SAPconnect into PDF/PostScript/PCL format and will be
embedded as attachment in the SMTP message. In this SAPscript/SmartForm-> PDF/PostScript/PCL
conversion plays this code page setting no role. So, in most practical cases, this code page setting will
not have any effect on the sent fax body itself. It will have only effect on some special fields as message
subject and recipient display name.

The Code Page combobox contains SAP code page numbers/names. This table shows the supported
KCS code pages <-> SAP code pages/MIME character set combinations:
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KCS codepage Language(s) Compatible SAP code pages / MIME character set

0 US and Western
European

1100 / iso-8859-1
1101 / us-ascii
1160 / windows-1252
1164 / iso-8859-15 1180 / iso-8859-1
1610 / iso-8859-9 (Turkish) *
1614 / windows-1254 (Turkish) *
1700 / iso-8859-7 (Greek) *
1704 / windows-1253 (Greek) *
1900 / iso-8859-4 4110 / utf-8 *
4310 / utf-8 *
8700 / iso-8859-6 (Arabic) **
8704 / windows-1256 (Arabic) **
8805 / windows-1258 (Vietnamese) *

1 Eastern European 1101 / us-ascii
1404 / windows-1250
1500 / iso-8859-5 (Cyrillic) *
1504 / windows-1251 (Cyrillic) *
1800 / iso-8859-8-i (Hebrew) **
1804 / windows-1255 (Hebrew) **
1810 / iso-8859-8-i (Hebrew) **
1904 / windows-1257 (Baltic) *
4110 / utf-8 * 4310 / utf-8 *
8700 / iso-8859-6 (Arabic) **
8704 / windows-1256 (Arabic) **

1251 Cyrillic 1504 / windows-1251 (Cyrillic)
4110 / utf-8 *
4310 / utf-8 *

1253 Greek 1704 / windows-1253 (Greek)
4110 / utf-8 *
4310 / utf-8 *

1254 Turkish 1614 / windows-1254 (Turkish)
4110 / utf-8 *
4310 / utf-8 *

1255 Hebrew 1804 / windows-1255 (Hebrew)
4110 / utf-8 *
4310 / utf-8 *

1256 Arabic 8704 / windows-1256 (Arabic)
4110 / utf-8 *
4310 / utf-8 *
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KCS codepage Language(s) Compatible SAP code pages / MIME character set

1257 Baltic 1904 / windows-1257 (Baltic)
4110 / utf-8 *
4310 / utf-8 *

1258 Vietnamese 8805 / windows-1258 (Vietnamese)
4110 / utf-8 *
4310 / utf-8 *

930 Traditional Chinese 8450 / gb2312
4110 / utf-8 *
4310 / utf-8 *

936 Simplified Chinese 8450 / gb2312
4110 / utf-8 *
4310 / utf-8 *

932 Japanese 8000 / shift_jis
8004 / shift_jis
8200 / iso-2022-jp
4110 / utf-8 *
4310 / utf-8 *

874 Thai 8604 / windows-874
4110 / utf-8 *
4310 / utf-8 *

* means: some national characters unconvertible

** means: most national characters unconvertible
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1. Configure the fax address type: click “Set” next to Fax checkbox

2. Enter * in the address area.
This means: all faxes will be routed to this SMTP node and so to TC/LINK-SC7.
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3. Select PDF or PS or PCL in the “Output Formats for SAP Documents” section for ‘SAPscript/Smart
Forms’ and for ‘ABAP List’. (The same format for both.)
The fax will be transmitted as attachment in this format. (Make sure that TC/LINK-SC7 is setup to be
able to convert the chosen format to KCS fax format. According image conversion license must also
be available on KCS. See Licensing.)

4. Enter the link domain into the Conversion into Internet Address / Domain field. SAP will use this
domain as the domain-part of the artificially constructed recipient SMTP address, created by
SAP from the SAP fax address. This setting must be the same as the registry setting TCLSM
\SMLinkDomain.

5. Click  button. (It will not be saved yet. Click  button also on the General node data to store the

address type configuration.)
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6. (Re-)configure the Internet address type / Pager (SMS) address type only if TC/LINK-SC7 will be
used also for SAP-outbound internet emails or SMS transport.
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STEP-6: Configure the Send Job (If Not Already Configured) (SCOT)
1. Go to SAPconnect Administration if you are not already there:

SAP menu: Tools > Business Communication > Communication > SAPconnect (or call
transaction SCOT)

2. Change to jobs view (View > Jobs), if you are not already in this view.

Explanation to send job: faxes, emails, SMSs that are sent from an SAP application are merely
put into a SAPconnect queue. A periodically running background process, the so called SAPconnect
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send job takes these messages from the queue and sends them via the configured SAPconnect
nodes.
Note that also the notifications generated by SAP (in case of SAP-inbound message transfer) are
sent towards KCS by this send job. So, even if you use TC/LINK-SC7 only for SAP-inbound message
transfer, the SAPconnect send job must be still configured!
If such a job is already scheduled (quite likely), then you can skip this configuration step. (E.g. on the
picture above, there is already a job called SEND_MAIL.) Otherwise, a send job can be created here
in the SAPconnect administration as follows:

3. Choose Job > Create (or the ‘new’ button on the toolbar), and specify a job name.

a. Place the cursor on the SAP&CONNECTALL variant.

b. Choose Schedule Job.

c. Choose Schedule periodically.

d. Specify a time interval (for example 2 minutes)

e. Choose Create.
The existing jobs are displayed in the SAPconnect jobs view as a calendar icons (see picture above).
To check the properties of an existing job, set the cursor on the calendar icon (and not on the line
with the job name!), and select Job | Display.

4. To check the steps of a scheduled job, click Step.

“SAP&CONNECTALL” procedure picks up all message types from the queue and sends to the
according SAPconnect node(s). If an already existing job performs another procedure than
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“SAP&CONNECTALL”, then it must be checked if it really deals with the message types we want to
deliver with TC/LINK-SC7.

STEP-7: Configure the Pager Service (SA14)
The pager service has to be configured only if TC/LINK-SC7 is used also for SMS transmission,
otherwise, you can skip this step.

1. Go to transaction SA14
2. Create a pager service entry as shown on the picture. E.g., service name is SMS.

3. Go to SAPconnect administration: SAP menu: Tools > Business Communication >
Communication > SAPconnect (or call transaction SCOT)

4. Go to View > Node
5. Double-click the SMTP node. The node configuration dialog opens.
6. Click the Set button next to the “Pager (SMS)” check box. The Pager(SMS) address type

configuration dialog opens.
7. Enter * into the address area.
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8. Enter the link-domain configured in the TC/LINK-SC7 registry setting TCLSM\SMLinkDomain into the
Domain field.
The system sends the SMS message as SMTP mail and this setting determines the domain part
of the recipient address in this mail. The local part of the recipient address will be generated in
this format: SMS=+recipient-number. In this way, the SMTP mail of the SMS message will get the
following recipient address: SMS=+recipient-number@link-domain

9. Click  button.

Note that the “Pager (SMS)” check box will not be set immediately on the parent dialog.
10. Click here also the  button.

Now, the changes will be stored on the node.

To Be Checked: mpi/total_size_MB (RZ1Ø)
The mpi/total_size_MB parameter set in the SAP application server profile (transaction RZ10, ‘instance’
profile) have to be set to a value that is greater than a quadruple of the largest mail to be sent. (For the
size of the mail, as a rule of thumb you can use approximately 150% of the size of the user data contained
in the mail).

Please, use similar steps as described in STEP-1 to view/change the mpi/total_size_MB parameter in the
SAP application server profile.

(According SAP Note: 690020 “SAPconnect send process hangs with large mails”.)

Optional SAP 7 Setup
This section describes optional configuration for SAP 7 setup.

50



Kofax Communication Server TCLINK-SC7 Technical Manual

Setting Up SAPconnect for Mixed Language PDF Conversion
Special configuration is needed to enable sending SAP-outbound documents with multi-language texts.
(E.g. Japanese characters and German umlauts in one single document.) This configuration is possible
only on Unicode SAP systems.

1. In the SAPconnect SMTP node, the “Output Formats for SAP Documents” must be set to PDF.

(If you want to convert also the RAW text parts in the message into PDF then specify also for ‘RAW
Text’ the PDF output format.)

2. Import Unicode device type if not yet available on SAP system. E.g. device type ZPDFUC from SAP
note 999712. The according device type file for import (ZPDFUC.PRI ) is available in this SAP note
as an attachment.
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On 7.10 SAP systems there is no need for this manual import. ZPDFUC is already available as
PDFUC.

a. Store ZPDFUC.PRI on the SAP frontend (SAPGUI) machine. (Download it from the SAP note
999712 or get it from Support / Kofax Austria.)
Transaction SPAD (Spool Administration), menu ‘For device types’ / ‘Import’

b. Select the ‘Device Type’ radio button and define the location of the ZPDFUC.PRI device type
file. (Radio button ‘From/on frontend’ must be selected if the file resides on the machine the
SAPGUI runs.)
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‘Successfully imported’ message:
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c. Install TrueType fonts for device type ZPDFUC.
Make sure that all Unicode ranges you use in the message documents are covered by the
installed TrueType fonts.
Exception: TrueType fonts which cover the following Unicode ranges do not have to be
installed manually: BASIC LATIN, LATIN-1 SUPPLEMENT, HAN/HANGUL (Chinese, Japanese
and Korean (CJK) fonts.) 
SAP note 1141788 suggests to install Lucida Sans Unicode TrueType font for PDF conversion
of documents with Asian scripts.
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(To get more detailed information on installing TrueType fonts, please refer also to the
document “How to install TrueType Fonts for UC PDF conversion.doc” attached in the SAP note
999712.)

d. Transaction SE38 (ABAP Editor), stat program RSTXPDF2UC (“Manager of TrueType fonts for
PDF converter.”)

e. Choose Install True Type Font, Font name of Lucida Sans Unicode is C:Windows\Fonts
\L_10646.TTF. Click Execute.
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(Note that the Windows Explorer (and also the Open File dialog) displays not the file name
but the font name. SAP, however, requires the font file name (L_10646.TTF) to be filled in the
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File Name field in the Open File dialog. Determining the file name: Right mouse menu on font
name / Properties.)

f. Respond ‘yes’ to the PDF font embedding.

g. Accept Workbench request.
Font will be installed.

h. From the RSTXPDF2UC program start screen (see above) select “List TrueType Fonts”. The
just loaded Lucida Sans Unicode will be displayed:

•
•
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3. SAPconnect: assign device type for PDF conversion

a. Transaction SCOT (SAPconnect), Menu Settings / Device Types for Format Conversion

b. Assign the ZPDFUC device type to the PDF target format / used document language /
document element to be applied on (=SAPscript/Smart Forms or ABAP list or RAW text or
Business object). (Create new entry if necessary.)

Register KCS solution into SAP Solution Landscape Directory (SLD)
The System Landscape Directory (SLD) is the central information repository for the SAP system
landscape (Software Catalogue) at the customer. All the installed and productively used products are
contained as Technical Systems with additional information, e.g. on which host which system is running.
Also KCS can be included there, so that a complete picture of the landscape is available.
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To do this you need to execute the following steps:
1. Edit the KCS.XML file (default location: “C:\TCOSS\TCLP”) and replace the following strings with the

actual customer values:
• ${LocalSystemName}: Description for the system instance installed at the customer’s side. This

is free text and might be different for every customer. Example: KCSsystem
• ${ComputerName}: Enter the name of the host where your system is installed. The value must

be entered in lower case without any network domain. This is free text and might be different for
every customer. Example: kcshost

2. Post the XML document to the SLD:
Send the XML document to the customer’s SLD with a standard HTTP POST command that can be
done with any web client after opening the connection to <sld_host>:<sld_port>.
POST /sld/ds HTTP/1.1
Authorization: Basic <user:password, BASE64 encoded>
dsxmlversion: 2.0
UserAgent: SLD Data Supplier sldreg
Content-Length: <Length of XML-Data>
<paste your XML for SLD registration here>

The user must be assigned to the DataSupplierLD security role and the LcrInstanceWriterLD role.
As a standalone solution for the Microsoft platforms to post the XML document to SLD, you can
use e.g. “WFetch” (http://www.microsoft.com/downloads/details.aspx?FamilyID=B134A806-
D50E-4664-8348-DA5C17129210&displaylang=en). Just fill the parameters as shown below, enter
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the http header parameters into the “Advanced Request” field and paste your XML file for the SLD
registration into the same field (don’t forget the empty line!):
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Chapter 3

Configuration

This section describes the configuration of TC/LINK-SC7.

Configuration of the TC/LINK-SC7 Service
As all other TC/LINK-derived product, TC/LINK-SC7 is configured mainly with registry settings. These
registry settings can be found here: HKEY_LOCAL_MACHINE\SOFTWARE\TOPCALL\<link-instance-
name>. The <link-instance-name> is after the first installation ‘TCLINKSC7’. (It can be changed after that.)

General Link Settings
The configuration settings under the subkeys Dirsync, General, Probe, Setup, TCIMG32, TCSI, TCTI,
Topcall are common TC/LINK settings and are described in the TC/LINK manual.

(Note that the settings under the subkey Dirsync are obsolete, because there is no dirsync support in TC/
LINK-SC7.)

TC/LINK-SM Specific Settings
The configuration settings under the subkeys TCLSM, TCMIME are inherited TC/LINK-SM settings and
are described in the TC/LINK-SM manual. Nevertheless, some of these settings have got in TC/LINK-SC7
context some TC/LINK-SC7 specific interpretation (e.g., the TC/LINK-SM ‘smart host’ is normally the SAP
SMTP server).

Important TC/LINK-SM-inherited registry settings to be configured for TC/LINK-SC7 operation:

Registry Key Type Default Possible Values / Meaning

TCLSM\Port2SMTP DWORD 0 The port configured on the SAP SMTP server (transaction RZ10
- see SAP configuration description above, STEP-1) must be
entered here. When 0 is entered, then the default SMTP port (=25)
will be used to contact the SAP SMTP server.

TCLSM\Port2TC DWORD 0 Configures the port the TC/LINK-SC7 SMTP server will listen to
for SAP-outbound messages. In additional SMTP relay installation
scenario it must be 25. Otherwise, if the SAPconnect SMTP node
is directly connected to the TC/LINK-SC7 (the Mail Host configured
on SAPconnect SMTP node is the TC/LINK-SC7 machine), then
this setting must be the same as the Mail Port configured on the
SAPconnect SMTP node. See SAP configuration description,
STEP-5.
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Registry Key Type Default Possible Values / Meaning

TCLSM\SMFixedRecipient Multi-
String

0 Fully qualified domain name of the SAP SMTP server(s) belonging
to the virtual host of the SAP client (’Mandant’) that TC/LINK-SC7
will connect. Each line holds 1 SAP server name.
If there are more than one alternative SMTP servers, then define it
in fallback-order. (The additional servers will be used by TC/LINK-
SC7 as fallback but not as load balancing.)

SMLinkDomain String “” The domain assigned to the TC/LINK-SC7 as SMTP server. If the
TC/LINK-SC7 SMTP server has a registered DNS name and TC/
LINK-SC7 is reached by DNS (additional SMTP relay installation
scenario) then the registered DNS name have to be used here.
SAP outbound messages must use recipient addresses with this
SMTP address domain part, in order to be served by TC/LINK-
SC7. Also, the SAPconnect SMTP node must be configured so,
that it builds the according fax and pager SMTP addresses with
this domain. That is, this domain must be entered on the fax and
pager address type setup on the SAPconnect SMTP-node, in the
“Parameter Conversion into Internet Address” / Domain edit field.
See SAP configuration description, STEP-5.

WaitTillPosted DWORD 0 Concerns the SAP-outbound SMTP conversation with TC/LINK-
SC7 as receiver partner.
0… Do not wait till posted to KCS. The TC/LINK-SC7 SMTP
listener returns SMTP-OK immediately after the message has
been successfully received by TC/LINK-SC7.
Other values… Wait till posted to KCS. The TC/LINK-SC7 SMTP
listener returns only then SMTP-OK when the message has been
successfully posted to KCS. The configured value defines the
according timeout in minutes.

TC/LINK-SC7 Settings
The few settings under the subkey SAP are the actual TC/LINK-SC7 specific settings. These are:

Registry Key Type Default Possible Values / Meaning

SAP\DIDLen String 3 (Used for originator mapping at SAP-outbound fax transfer.) Length of the
DID extension number. It defines how many digits at the end of the fax
number must be taken to search for the according originator shadow user
on KCS. The shadow user on KCS must have an extension-only proxy
fax number. See more on originator mapping in Originator shadow user,
originator address, originator mapping.

SAP\OwnService String SC7 KCS service for sending messages to SAP (SAP-inbound). TC/LINK-SC7
uses this setting to create a TC/LINK-SC7 service with this name on TC/
LINK-SC7 start.

SAP\PagerService String SMS Relevant only when TC/LINK-SC7 is used (also) for SMS message transfer.
Value: the name of SMS service configured on SAP (transaction SA14). See
SAP configuration description above, STEP-7.

SAP\SAPDomain String “” Value: the SAPconnect Default Domain parameter must be entered here as
configured on SAP (Transaction SCOT). See SAP configuration description
above, STEP-4.
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Corresponding Parameters on SAP Side <-> on TC/LINK-SC7
Side

Some settings must coincide on SAP side and on TC/LINK-SC7 service side. These consistency
conditions must be checked / maintained manually:

Configuration on SAP Must be the same as

‘Mail Host’ parameter configured on the SAPconnect
SMTP-node (Transaction SCOT)

domain name or IP address of the SMTP relay machine
OR:
domain name or IP address of the TC/LINK-SC7 machine
(depending on the installation scenario chosen)

‘Mail Port’ parameter configured on the SAPconnect
SMTP-node (Transaction SCOT)

the (SMTP listener) port configured on the SMTP relay server
OR:
TCLSM\Port2TC
(depending on the installation scenario chosen)

Domain parameter at the fax address type setup on
the SAPconnect SMTP-node (Transaction SCOT)

TCLSM\SMLinkDomain

Domain parameter at the Pager(SMS) address type
setup on the SAPconnect SMTP-node (Transaction
SCOT)

TCLSM\SMLinkDomain

SAP SMTP server machine names TCLSM\SMFixedRecipient

SAPconnect Default Domain (Transaction SCOT) SAP\SAPDomain

SMTP Port defined on the virtual server belonging to
the SAP client (SAP application server profile)

TCLSM\Port2SMTP

(Consistency must be maintained only if TC/LINK-
SC7 is used for SMS transfer!)
SMS service configured in SA14 transaction.

SAP\PagerService
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Operating / Using

This section describes how to use TC/LINK-SC7.

Sending SAP Outbound (SAP->KCS)
This section describes how to send messages from SAP to Kofax Communication Server.

Addressing
With proper message addressing on SAP side we make sure that:

1. SAP-outbound messages will be routed by SAP to TC/LINK-SC7

2. TC/LINK-SC7 gets the “service”, “number” and optional the “answerback” information, encoded in
some way in the SAP proprietary addressing syntax, so that TC/LINK-SC7 can route the message
forward to the Kofax Communication Server to the proper service and number.

Note that goal a) above will be reached solely by using addresses that match to the address area
definition configured on the SAPconnect SMTP node and not by using some special addressing syntax.

E.g. when the address area definition for SAP ‘INT’ message type (internet email) is defined as ‘*’ on the
SAPconnect SMTP node, then all INT messages will be routed to TC/LINK-SC7, independently of the
syntax of the email address.

a) Sending fax

No special addressing syntax required, standard SAP ‘FAX’ address type and syntax can to be used.

E.g.: AT 1863538127

TC/LINK-SC7 will send this message to the configured default fax service (registry setting Topcall
\FaxService). Using this addressing it is not possible to pass “answerback” definition to TC/LINK-SC7.

Note The SAPconnect SMTP node will convert this address internally, when transferring the message
through the SMTP protocol, to the following “to”-address: FAX:+431863538127@<domain> where
<domain> is the domain configured at the SAPconnect SMTP node on the fax address type settings
dialog (“Conversion into Internet Address / Domain” setting). Let’s notice, that the existence of this
“FAX:”-syntax in the recipient address conveys here the service information, that is, instructs TC/LINK-
SC7 to use the configured fax service.

b) Sending SMS
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No special addressing syntax required, standard SAP ‘PAGER(SMS)’ address type and syntax can be
used.

E.g.: SMS1:+4364410101010 where SMS1 is a configured pager service name (‘service’ in SAP sense!)
on SAP. (See transaction SCOT / Settings / Pager service.) This name must be configured also at TC/
LINK-SC7 in the registry setting SAP\PagerService.

TC/LINK-SC7 will send this message to the configured default SMS service (registry setting Topcall
\SMSService).

Note, that the SAPconnect SMTP node will convert this address internally, when transferring the message
through the SMTP protocol to the following format: SAP-SMS-service:number@domain where <domain>
is the domain configured at the SAPconnect SMTP node on the Pager(SMS) address type settings dialog
(“Conversion into Internet Address / Domain” setting).

Note, that TC/LINK-SC7 identifies the message as SMS message when SAP-SMS-service in the address
local part above is identical with the registry setting SAP\PagerService.

c) Sending email

No special addressing syntax required, standard SAP ‘INT’ address type and internet e-main syntax can
be used: local-part@domain

When the <domain> is different from the link-domain (registry setting TCLSM\SMLinkDomain) – which is
always the case with real email addresses – then TC/LINK-SC7 will send this message to the configured
default SMTP service (registry setting Topcall\SMTPService).

That is, the TC/LINK-SC7 / Kofax Communication Server will simply relay the email to the recipients.

d) Sending to any Kofax Communication Server service

The following special addressing syntax required: SAP ‘INT’ address type has to be used, and the service,
number and answerback information is encoded in the local-part or in the display-name-part of the internet
email address in the following way:

Syntax-1) service#number@link-domain or

service#number#answerback@link-domain

Syntax-2) number<service@linkdomain>

Where the link-domain is the domain configured in the registry setting TCLSM\SMLinkDomain.

The separator (default: “#”) can be configured in the registry setting TCLSM\Separator.

The drawback of syntax-1) above is that the local-part is very restrictive concerning allowed characters:
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Only characters between 0x20 to 0x7F and not grayed out in the above table can be used.

That is why syntax-2) above was introduced. The display-name-part in an SMTP address can contain
blanks and national characters. So, it can hold e.g. a Lotus Notes address with space character.

Note Using the addressing address type=‘INT’ and FAX#00431863538127@<link-domain> can result
different fax content than using address type=‘FAX’ and AT 1863538127. SAP prepares 'INT' messages
and 'FAX' messages in a different way. E.g. SAP generates optionally coversheets for ‘FAX’ messages.

e) Sending to a Kofax Communication Server user

Sometimes, the recipients are not directly addressed, but the message will be sent to a Kofax
Communication Server user, and the message will then be automatically forwarded by one or more In-
event(s) configured at the Kofax Communication Server user. To support this case, there is a simple
syntax to send from SAP to a Kofax Communication Server user:

SAP address type: ‘INT’. The local part of the internet email address must hold the KCS user ID or an
SAPIN-address. The domain part has to be the link-domain configured in the registry setting TCLSM
\SMLinkDomain.

user-id or SAPIN-address@link-domain

First, the local part will be interpreted as user ID and it will be searched for Kofax Communication Server
user having this user ID. When no such user found, then, as fallback, the local part will be reinterpreted
as SAPIN service address and it will be searched for Kofax Communication Server user having this as
inactive SAPIN service address. The SAPIN service (default: SAPIN) can be configured in the registry
setting Topcall\SAPINService.

The mechanism with the SAPIN address has the following advantage: when the Kofax Communication
Server user ID contains special characters, then the local part of an SMTP address cannot hold this user
ID because of character set restrictions. This problem can be worked around by defining an alternative
SAPIN address at the Kofax Communication Server user using only the restricted character set of an
SMTP address. This SAPIN address can then be used in the local part of the SMTP address instead of
the real user ID.

Originator Shadow User, Originator Address, Originator Mapping
It makes sense to create for some or for all potential “originator” SAP users a corresponding “shadow
user” on the Kofax Communication Server. This configuration enables to configure originator-specific
default sending options (like e.g. originator-specific cover sheets) or originator-specific security
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restrictions. (Please refer to the TC/LINK manual to learn more about originator shadow users and
originator mapping.)

Note TC/LINK-SC7 has no “dirsync” functionality (automatic creation of such shadow users based on
the address book of the connected mail system, in our case SAP), so the shadow users must be created
manually on the Kofax Communication Server.

Take care that the proxy address definitions for these shadow users are correct, so that TC/LINK-SC7 can
in fact find the shadow user corresponding to the SAP user who sent the SAP-outbound mail (=originator).
When the corresponding shadow user will not be found, then applying the originator-specific sending
options is also not possible!

So, the following address must be defined as inactive proxy address in the shadow user to make sure that
the originator mapping (=process of finding the according shadow user) works:

The SAPconnect SMTP interface builds the originator address (=SMTP “from”-address) in the SAP-
outbound message in the following way when sending INT message type (email):

1. the internet address configured at the originator SAP user (See transaction User maintenance,
SU01)
or, when no internet address is defined for the originator SAP user:

2. originator-SAP-user-ID@default-domain, where the default-domain is the domain configured in the
SCOT | Settings | Default domain transaction.

For FAX and SMS message types the situation is more complicated:

In SAP systems where the SAP error correction “SAP Note 1161435” was not yet applied, the originator
address will be built by SAPconnect just the same way as described above for the INT message type.
That is, the internet address and not the fax/SMS address of the originator SAP user will be sent by
SAPconnect.

However, in SAP systems where the SAP error correction “SAP Note 1161435” was already applied,
SAPconnect builds the originator address using the fax / SMS address configured in the originator SAP
user.

E.g.:

FAX:+43186353199@SCOT-default-domain

or:

SMS:+43186353199@SCOT-default-domain

In this case, the ‘originator mapping by fax extension’ feature is available:

Originator mapping by fax extension (DID digits):

If you enter only the fax extension (this is 199 in the above example, supposing SAP\DIDLen = 3 is
configured) as proxy address into the shadow user on KCS, (according service is irrelevant), then TC/
LINK-SC7 will still find this shadow user. The registry setting SAP\DIDLen defines how many trailing
characters TC/LINK-SC7 extracts from the SMTP address local part sent by SAP to match the fax
extension.

E.g.:

67



Kofax Communication Server TCLINK-SC7 Technical Manual

SAP\DIDLen = 2 is configured

SMTP address local part = “FAX:+43186353199”

# Fax extension assumed by TC/LINK-SC7 is 99. Shadow user having this extension as proxy address
will be searched by TC/LINK-SC7.

Nevertheless, SAPconnect can be configured in the SXPARAMS parameter table (Transaction: SM30) to
send the email address of the originator SAP user instead of the fax or SMS address, also in case of SAP
outbound fax or SMS messages with setting the following settings:

Parameter: SMTP_USE_EMAILADDR_FOR_FAX_SENDER # Value: X

Parameter: SMTP_USE_EMAILADDR_FOR_SMS_SENDER # Value: X

In this case, however, the “originator mapping by fax extension” feature is not available.

Refer also SAP Note: 1161435 – “Sender address for FAX using SMTP”.

Notifications to SAP
TC/LINK-SC7 supplies delivery/non-delivery notifications to SAP, if these are requested in the SAP-
outbound message. (This is the typical case; see below how to configure it.)

Read notification requests in the SAP outbound message are ignored by TC/LINK-SC7. TC/LINK-SC7
does not send read notification to SAP. (When sending fax or SMS, this does not mean any restriction,
because there is no read notification in these transactions.)

Configuring SAPconnect to request or not to request delivery/non-delivery notifications:

Transaction SCOT | menu Settings | Confirmation of receipt

Typically, the “SAPconnect expects receipt confirmations…” mode is set and this mode is supported by
TC/LINK-SC7 by sending the expected notifications (=confirmations).
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In “SAPconnect does not expect receipt confirmation” mode the SAP-outbound message will not contain
delivery/non-delivery notification requests and so TC/LINK-SC7 will not supply them either.

The delivery/non-delivery notifications sent by TC/LINK-SC7 to SAP are not plain mails, but RFC1891…
1894 notification messages. They will be used by SAPconnect to update the Send status flag of the SAP
send order. (However, in non-delivery case SAPconnect itself will generate also a plain mail, see further
below.) The Send status flag of the SAP send order are displayed e.g. in the SAP Business Workplace in
the Outbox of the originator SAP user in the Documents list:

Note The Sent status is displayed in this overview list only for SAP send orders with one recipient. In
case of more recipients, the sent document must be opened (double-click on the according list line) and
on the Recipient list tab there is a status display with detailed transmission history per recipient.

Note also, that the Send status pictogram display in the SAP Business Workplace is not correct.
Frequently, instead of the status sent (  ) pictogram the status transmitted (  ) pictogram is displayed.
(E.g. see message ‘tst-2’ in our screenshots.)

For the correct Send status pictogram display go to transaction SCOT / menu Utilities / Overview of send
orders:
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In ‘SAPconnect expects receipt confirmation’-mode (typical case) the Send status flag can have the
following values:

waiting Message not yet transferred to the connected SMTP server

sent Data was successfully transferred to the connected SMTP server

transmitted Delivery notification was received

errors a) Error routing to the connected SMTP server 
b) Message successfully transferred to SMTP server but non-delivery notification
was received

In this case, the SAPconnect transmission history tracking relies on the delivery/non-delivery notifications
sent by TC/LINK-SC7.

In ‘SAPconnect does not expect receipt confirmation’-mode the Send status flag can have the following
values:

waiting Message not yet transferred to the connected SMTP server

sent Message successfully transferred to the connected SMTP server
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errors Error routing to the connected SMTP server

In ‘receipt confirmation not expected’ mode the message transmission is not further tracked after being
successfully transferred to the connected SMTP server and the whole transaction is considered to be
successful. In this case, it is recommended to configure TC/LINK-SC7 for ‘wait till posted’ mode. (Registry
setting TCLSM\WaitTillPosted.) This means, the SMTP conversation (with TC/LINK-SC7 as receiver
partner) waits until the message is arrived on KCS. TC/LINK-SC7 sends SMTP-OK only then, when the
message is in fact successfully arrived in KCS.

“No message lost” fault tolerance consideration: The ‘SAPconnect expects receipt confirmation’-mode
makes sure that it is possible to determine whether a message was in fact delivered or not. In this mode
(almost) all SAP send order gets either the transmitted or the errors flag. So there will be no ambiguity as
to the message was delivered or not. Only when a failure occurs during the send-transaction (perhaps
during the sending of the delivery notification) and the SAP send order remains in sent status, then is the
success of the delivery not known on SAP-side. But even in this case, the KCS server can be checked
(e.g. using TCfW) whether this particular message was delivered or not.

As mentioned above, SAPconnect generates also a plain mail from the non-delivery notification and
places it in the inbox of the originator SAP user. If TC/LINK-SC7 is configured to include non-delivery
coversheet in the non-delivery notification (this is the default behavior), then this non-delivery report will
appear in this plain mail as attachment. Please refer to TC/LINK manual for the configuration of the non-
delivery coversheet. (See‘Notifications into mail’)

Note, that the plain non-delivery notification mail is generated by SAPconnect as express mail, so a popup
window will be displayed on reception:

The SAPconnect SMTP interface uses the RFC1891…1894 method (that is, the ESMTP ‘DNS’ feature) to
request and process delivery/non-delivery notifications. Consequences for the setup:
• If the SAPconnect SMTP node is connected to TC/LINK-SC7 with an intermediate SMTP relay server

(this should be the normal case), then this SMTP relay server must support the ESMTP ‘DNS’ feature.
• The TC/LINK-SC7 registry setting TCLSM\MIMENotifFormat = 3 (already set so by the TC/LINK-SC7

installation procedure; it instructs TC/LINK-SC7 to use the RFC1891…1894 method) must not be
changed!

Furthers, please consider also restriction in the chapter “Installation for Multiple SAP Clients (‘mandant’)”
to avoid SAP-inbound notification assignment problems in (not-validated) multiple-client-connection
scenarios.

Sending Options
Embedded ‘++ directives’ in PCL/PS binary data

71



Kofax Communication Server TCLINK-SC7 Technical Manual

The “Text Directives in Binary Attachments” TC/LINK feature can be exploit by defining dummy PRINT-
CONTROLs (containing the KCS ++ directives) in the SAPscript/Smart Form template of the message to
be sent. (Refer to the PRINT-CONTROL SAPscript command in the SAP help.)

This work for PCL and PS output formats but not PDF. The PDF converter ignores the PRINT-CONTROL
sequences inserted into the forms.

For more information on the available ++ directives and on the configuration/activation of the “Text
Directives in Binary Attachments”-mode please check “Text Directives” in the TC/LINK manual.

Sending SAP Inbound (KCS->SAP)
This section describes how to send messages from Kofax Communication Server to SAP.

Addressing
Below, it is described the addressing syntax as TC/LINK-SC7 requires it for sending a message to an SAP
7 user. This addressing syntax has to be used in the following situations:
• If the ‘In’-event method is used for routing the messages to TC/LINK-SC7 (in case when the recipient

SAP user has an according shadow user on the Kofax Communication Server), then this is the syntax
which have to be used in ‘In’-Events in the Free address / Number field.

• When sending a mail into SAP from a remote mail system with a remote TC/LINK, then this is the
syntax which has to be used in the <number> part of the remote TC/LINK addressing syntax.

• Also, this syntax must be used in ‘number’ part of the “<service>,<number>” TCfW addressing when
sending some test message from TCfW to SAP.

a) Sending fax to SAP

Syntax: FAX:fax number configured at the recipient SAP user

E.g.: FAX:+4318635370199
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b) Sending email to SAP

Syntax:

email address configured at the recipient SAP user

or:

SAP-user-ID@default-domain (if no email address is configured at the recipient SAP user)

E.g.: sapuser@company.com

(Where default-domain is the domain set in transaction SCOT / menu Settings / submenu Default
domain.)

Alternatively, the ‘old’ TC/LINK-SC addressing with “SMTP” prefix can also be used:
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Syntax: SMTP:email address as above

E.g.: SMTP:sapuser@company.com

c) Sending SMS to SAP

Syntax: pager service defined on SCOT:pager number configured at the recipient SAP user

E.g.: SMS:+431234

Prerequisite configuration on SAP:

1. The SMS number is defined at the SAP user recipient: (‘Maintain User’ program in transaction
SU01 / ‘Other communication…’ button / ‘Pager services’ communication method)
Warning! The pages number must contain a valid country code with ‘+’ syntax (like +43).

2. The pager service ‘SMS’ is defined in SAPconnect: (Transaction SCOT / Settings / Pager service)
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Routing Incoming Faxes Without Shadow Users
As there is no possibility to make DirSync with TC/LINK-SC7, the operation without shadow users
(corresponding to SAP users) will be the most typical situation. That is, no shadow user ‘In’-event routing
will be possible. In this case, RR99 routing must be used:

Example

Requirements
• Assume 600 SAP users with own fax numbers 0166133-100, 0166133-101, …, 0166133-699 defined

within their SAP user profiles.
• If any incoming fax could not be delivered to appropriate SAP user (wrong or not defined DID, e.g.,

0166133-900) it should be delivered to SAP System Administrator’s fax number 0166133-000.
• Incoming faxes should be converted to TIFF G4 format.

Solution
• Create TOPCALL service FXI with prefix S:
• Set the configuration line 235 of fax module(s) to FXI$
• Create TIFF G4 queue user TCLSC7Q4 (if not created automatically by TC/LINK-SC7)
• Add following line to the **ROUTE section of RR99:

**ROUTE
S:~,TCLSC7Q4:FAX:0166133~\TCLSCQ4:FAX:0166133000

This line prepares complete SAP recipient’s fax number from its fix part 0166133 and DID got from fax
module (SAP users must be addressed by their complete fax numbers, not only by DID extensions).
If SAP returns non-delivery notification, the fax would be sent to the alternate SAP fax recipient
0166133000.

Originator Address
TC/LINK-SC7 sends the following originator address in a SAP-inbound message:

(Note that this information is not directly relevant when operating/using TC/LINK-SC7, however it can be
interesting for troubleshooting purposes.)

When the message is coming from the configured SMTP service (registry setting Topcall\SMTPService)
then TC/LINK-SC7 will send simply the email address of the sender as originator address with the
message: local-part@sender-domain

When the message is coming through a Kofax Communication Server originator shadow user (this is the
case, when the originator has a shadow user on the Kofax Communication Server and the sender remote
link or fax module successfully performed the originator mapping), then TC/LINK-SC7 will send normally
the KCS userid of the originator shadow user as originator address:

KCS-userid@link-domain

where link-domain is the domain configured in the registry setting TCLSM\SMLinkDomain.

However, when the KCS userid contains also characters not allowed in an SMTP-address-local-part (e.g.
ö, ü, …), then instead, the SAPIN address, if any, defined at the originator shadow user will be taken:
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SAPIN address of originator shadow user@link-domain

Otherwise (message is not coming from the configured SMTP service and there is no according originator
shadow user on a Kofax Communication Server), then TC/LINK-SC7 will send the following originator
address:

service#number#answerback@>link-domain

Where service is the service belonging to the remote link (or fax module) sending the message, number
is the originator address/number sent by the remote link (or fax module) and link-domain is the domain
configured in the registry setting TCLSM\SMLinkDomain.

Again, when the number part here contains special characters not allowed in SMTP-address-local-part
(e.g. space character or umlaut character, etc.) then, instead, the following originator address syntax will
be used:

number <service@link-domain>

That is, the number part is placed in the display-name part of the SMTP address, where there is no
character set restriction.

Notifications from SAP
Full support of delivery/non-delivery/read notification to KCS.

As SAPconnect sends delivery/non-delivery notifications so Topcall\NotifMail=1 is set by default and
should not be changed for normal operation.

As SAPconnect sends read notifications so General\SupportsReadNotif=1 is set by default and should not
be changed.

TC/LINK-SC7 supplies the notifications to KCS according to the standard TC/LINK KCS-send-order
termination logic. Please consult the TC/LINK manual for more detail, chapter ‘Notifications from mail’.

SAPconnect and TC/LINK-SC7 uses the RFC1891…1894 notification exchange method (ESMTP ‘DNS’
feature) so TCLSM\MIMENotifFormat=3 is set by default and should not be changed.

(For more understanding on the Topcall\NotifMail, General\SupportsReadNotif settings mentioned above,
please refer to the TC/LINK manual.)

Warning! As SAPconnect sends the notifications from SAP to KCS by means of the SAPconnect send
job, so the SAPconnect send job must be configured. See SAP 7 setup for TC/LINK-SC7, STEP-6.
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Troubleshooting

This section describes how to troubleshoot errors in TC/LINK-SC7.

Trace Possibilities on TC/LINK-SC7 Side
This section describes how to use TC/LINK-SC7 trace files.

TC/LINK-SC7 Trace File
The trace file stays (as with all other links) in the C:\TCOSS\Trace directory and has the same name as
the link instance plus a sequence number. (E.g. C:\TCOSS\Trace\TCLINKSC70.trc).

Set General\Tracelevel = 255 to get more verbose trace.

Increase MaxTraceFileSize and MaxTraceFiles and to get larger and more trace files. E.g., the
configuration MaxTraceFileSize =2000 and MaxTraceFiles=20 creates 2MB large trace files and the last
20 trace files will be preserved.

Tracing the TCSI Data Block Transfer from/to KCS
The following registry settings activate tracing the TCSI blocks (belonging to the messages and
notifications) sent to and received from KCS by the link.

General\MailDebug = 1

Topcall\TCSIDebug = 1

General\TraceSmall = 1 (to suppress the binary-block dumps, because they floods the trace)

E.g. an excerpt from a TCSI message-block trace looks like this:
...
...
08/14:49:35.292 (1550/150c) ----- Converted Message from Mail    -----
08/14:49:35.292 (1550/150c) set_entry_ms_mail = (
08/14:49:35.292 (1550/150c)  cl_time/time_created = "080808:134917",
08/14:49:35.292 (1550/150c)  cl_integer/int_npag = 1,
08/14:49:35.292 (1550/150c)  cl_textstring/ts_rec_queue = "TCLSC7Q4",
08/14:49:35.292 (1550/150c)  l_env_cont/un_content = (
08/14:49:35.292 (1550/150c)   set_header = (
08/14:49:35.292 (1550/150c)    cl_textstring/ts_ref = "tst-1",
08/14:49:35.292 (1550/150c)    cl_textstring/ts_message_id = "<ADR33000000000012@sap-
sys.company.com>",
08/14:49:35.292 (1550/150c)    cl_textstring/ts_comments_1 = "",

77



Kofax Communication Server TCLINK-SC7 Technical Manual

08/14:49:35.292 (1550/150c)    cl_textstring/ts_content_type = "text/plain; charset=
\22us-ascii\22",
08/14:49:35.292 (1550/150c)    cl_textstring/ts_send_time = "Fri, 8 Aug 2008 14:49:17
 +0200 (CET)",
08/14:49:35.292 (1550/150c)    l_received = (
08/14:49:35.292 (1550/150c)     cl_textstring/ts_received = "from sap-sys.company.com
 by AT01D036.emea.kofax.com with SMTP for pasz2@emea.kofax.com; Fri, 08 Aug 2008
 14:49:35 +0200"
08/14:49:35.292 (1550/150c)    ),
08/14:49:35.292 (1550/150c)    l_extensions = (
08/14:49:35.292 (1550/150c)     cl_textstring/ts_xfield = "X-Mailer: SAP Web
 Application Server 7.00"
08/14:49:35.292 (1550/150c)    ),
08/14:49:35.292 (1550/150c)    cl_textstring/ts_cost_center = "GUEST",
08/14:49:35.292 (1550/150c)    set_entry_rs/set_entry_rs_originator = (
...
...

Note that the message blocks are traced in two stages: before and after the TC/LINK message
conversion. The message conversion includes the document/image conversion (if any) but also the
address transformations according the TC/LINK-SC7 specific map file (C:\TCOSS\TCLP\SC7.MAP). So,
the effect of the map file conversion can also be examined in the trace.

Tracing the SMTP Conversation
Registry setting TCLSM\TCPDebug = 1 activates tracing the SMTP conversation / data transfer. The
according trace line will be written into the TC/LINK-SC7 trace. These are the lines beginning with ‘TCP->’
or ‘TCP<-‘.
...
...
08/14:49:34.995 (1550/46c) TCP<-220 AT01D036.emea.kofax.com (TC/LINK-SM Version
 2.05.00) ESMTP service ready
08/14:49:35.026 (1550/46c) TCP->EHLO sap-sys.company.com
08/14:49:35.026 (1550/46c) TCP<-250-AT01D036.emea.kofax.com
250-DSN
250 HELP
08/14:49:35.026 (1550/46c) TCP->MAIL FROM:<ddic@sap-sys.company.com>
 ENVID=ADR33000000000012
08/14:49:35.026 (1550/46c) TCP<-250 originator OK
08/14:49:35.026 (1550/46c) TCP->RCPT TO:<pasz2@emea.kofax.com> NOTIFY=SUCCESS,FAILURE
 ORCPT=rfc822;pasz2@emea.kofax.com
08/14:49:35.026 (1550/46c) TCP<-250 recipient OK
08/14:49:35.026 (1550/46c) TCP->DATA
08/14:49:35.026 (1550/46c) TCP<-354 Start mail input, end with <CRLF>.<CRLF>
08/14:49:35.042 (1550/46c) TCP->Date: Fri, 8 Aug 2008 14:49:17 +0200 (CET)
08/14:49:35.042 (1550/46c) TCP->From: DDIC <ddic@sap-sys.company.com>
08/14:49:35.042 (1550/46c) TCP->Subject: tst-1
08/14:49:35.042 (1550/46c) TCP->To: <pasz2@emea.kofax.com>
08/14:49:35.042 (1550/46c) TCP->Message-ID: <ADR33000000000012@sap-sys.company.com>
08/14:49:35.042 (1550/46c) TCP->MIME-Version: 1.0
08/14:49:35.042 (1550/46c) TCP->Importance: Normal
08/14:49:35.042 (1550/46c) TCP->X-Priority: 3 (Normal)
...
...

One other possibility is setting TCLSM\SMDebug = 1. (This registry setting, type: DWORD, must be
created manually!) In this mode the intermediate files storing the SMTP conversation data will not be
removed, only renamed to .LS_ and .TS_. These files can be found in the TCLSM\SMTempDir directory.
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This setting may be activated only for a short period of time for troubleshooting purposes, otherwise disk
overflow can occur. Afterwards, the .LS_ and .TS_ files have to be removed manually.

Tracing the Image Conversion
The setting TCIMG32\TraceLevel = 255 results a more verbose TCIMGIO trace output into the standard
TC/LINK-SC7 trace file. (The TCIMGIO image conversion module is used e.g. for PCL / PS / PDF to fax
format conversions when sending SAP-outbound faxes.) Additionally, if TCIMG32\ProblemPath is defined,
then the input images of failed TCIMGIO conversions will be stored here for troubleshooting purposes.

Trace Possibilities on SAP Side
This section describes how to troubleshoot errors on SAP.

SAPconnect Routing Test
The SAPconnect routing test (Calling: transaction SCOT / menu Utilities / Routing test) can be used to
determined which SAPconnect node is responsible for routing to a given recipient.

So, it can be tested whether a message that meant to be processed by TC/LINK-SC7 will in fact be routed
to the SAPconnect SMTP node. That is, whether the address area definitions on the SAPconnect node(s)
are properly configured.

Overview of Send Orders
In ‘Overview of send orders’ it is possible to check all outbound message send orders (filtering by date,
send status is possible), display the belonging transmission history and also the according SAPconnect
log.

Calling: transaction SCOT | menu Utilities | Overview of send orders
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SAPconnect Trace
Calling: Transaction SCOT | menu Utilities | Trace | Internal trace

For the most trace information switch on trace in all tree given category: Outbound, Inbound, Global.

Use the Display button to display the traces. (Each message transfer transaction has its own trace.)

In the trace display, it is also possible to show the content of the data structures by clicking on the glasses
symbol at trace lines where the trace text begins with the ‘Structure:’ word. See screen shot:

80



Kofax Communication Server TCLINK-SC7 Technical Manual

81


	Table of Contents
	Preface
	Differences TC/LINK-SC7 <-> TC/LINK-SC
	Licensing

	Installation
	Installation Scenarios
	Additional SMTP Relay Scenario
	Direct Link Connection Scenario
	Windows NLB-Cluster Connection Scenario
	Installation for Multiple SAP Clients (‘mandant’)

	Prerequisites
	Overview of Installation Steps
	Installation of the TC/LINK-SC7 Service
	SAP 7 Setup for TC/LINK-SC7
	Overview
	STEP-1: Configuring the SMTP Listener on the SAP Web Application Server (RZ1Ø)
	STEP-2: Creating a Service User for the Incoming Mail Processing (SUØ1)
	STEP-3: Setting Up the SMTP Server (SICF)
	STEP-4: Defining the Default Domain (SCOT)
	STEP-5: Configuring the SAPconnect SMTP Mail Server Node (SCOT)
	Explanation

	STEP-6: Configure the Send Job (If Not Already Configured) (SCOT)
	STEP-7: Configure the Pager Service (SA14)
	To Be Checked: mpi/total_size_MB (RZ1Ø)

	Optional SAP 7 Setup
	Setting Up SAPconnect for Mixed Language PDF Conversion
	Register KCS solution into SAP Solution Landscape Directory (SLD)


	Configuration
	Configuration of the TC/LINK-SC7 Service
	General Link Settings
	TC/LINK-SM Specific Settings
	TC/LINK-SC7 Settings

	Corresponding Parameters on SAP Side <-> on TC/LINK-SC7 Side

	Operating / Using
	Sending SAP Outbound (SAP->KCS)
	Addressing
	Originator Shadow User, Originator Address, Originator Mapping
	Notifications to SAP
	Sending Options

	Sending SAP Inbound (KCS->SAP)
	Addressing
	Routing Incoming Faxes Without Shadow Users
	Originator Address
	Notifications from SAP


	Troubleshooting
	Trace Possibilities on TC/LINK-SC7 Side
	TC/LINK-SC7 Trace File
	Tracing the TCSI Data Block Transfer from/to KCS
	Tracing the SMTP Conversation
	Tracing the Image Conversion

	Trace Possibilities on SAP Side
	SAPconnect Routing Test
	Overview of Send Orders
	SAPconnect Trace



